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THIS PRESENTATION IS ONLINE
Go to:
http://users.stlcc.edu/rschumacher/ppt-video.html
to view the YouTube version of this presentation, and
to obtain the files that created it.

Presentation files:
PowerPoint PPTX
Audio MP3
Narration Script
Generated Video

WHY CREATE VIDEOS FROM
POWERPOINT?
PRESENTATION CAPTURE
This is typically used to provide students with
convenience options allowing them to watch a
missed PowerPoint-based lecture, review difficult or
complex content, closely examine procedure steps, or
watch special events or lectures that cannot be
attended in person. It also provides another
opportunity to repurpose content.
Extensive editing of the audio recording is highly
recommended to improve usability and condense the
length of the recording. Since usually only the
lecturer is being recorded, it is important for them to
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always repeat any questions asked by students. Since
many presenters have a less than dynamic slide deck,
you will usually need to add many more visuals and
transitions to the PowerPoint file.

VIDEO PODCAST
An “enhanced podcast” provides a way to include
visual content reinforcing the original narration.
Video podcasts are required when the visuals are
crucial in effectively communicating the content to
the learner.
By adding slides to an existing audio podcast, you can
repurpose existing content in a new format. The trick
here is to come up with the appropriate visuals.

KNOWLEDGE ON DEMAND
Also called “micro-lectures” and “knowledge bursts,”
“knowledge on demand” is learning focused on a
specific learning objective – how to quickly do a
specific task.
They are designed as very short, engaging activities to
teach essential skills on specific narrow topics, usually
in under two or three minutes. They provide on
demand “just what you need to know” training. A
“knowledge on demand” video is a great method to
deliver solutions for common knowledge gaps and
just-in-time performance improvement.
“Knowledge on demand” is at its best when short,
targeted, and learner directed. The challenge is to
create and deliver compelling, accurate content.
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Content with a long “shelf life” typically works best
for public distribution. Remember that in many cases,
“less is more.”

CONTENT DEVELOPMENT

ONLINE LEARNING ADVANTAGES

In the planning phase you develop content and
narration, or setup to record a live event.

•
•
•
•
•

Just-in-time performance improvement.
Solutions for common knowledge gaps.
Shows material in a consistent, repeatable form,
typically faster paced.
Minimize instructor/expert time investment in
training.
Content available 24/7 worldwide.

REQUIREMENTS
Low production costs, and limited software
requirements, are the main advantages of this
approach.

PLANNING

RECORDING
The final quality of your video is directly related to
the quality of your audio recording. Take every action
possible to make the best audio recording you can.
And make sure you have permission before recording
anyone.

PRODUCING

You need PowerPoint 2010 as that version has the
“Create Video” option we will be using.

In production you edit and optimize the audio file,
add “missing” slides and content, incorporate slide
transitions and object animations, synchronize the
slides to the audio, and output a video file.

Audio editing software is used to improve usability
and condense the recording.

PUBLISHING

And you will need a reliable way to record a highquality audio file.

VIEWER EXPECTATIONS
They expect your video to be interesting and useful,
concise, and visually engaging.
They also expect the audio to be clear and
understandable. High-quality sound is a requirement,
not an option.
And finally, they expect your video to be available in
the format, and on the devices, they want to use.
For videos with public distribution, this usually means
it is published on YouTube using HD video quality and
standards.
An important difference of HD video is the aspect
ratio, the proportion of the screen width to height.
For standard video this ratio is 4 to 3. HD has changed
this to a widescreen 16 by 9 format, more like
proportions of a movie theatre screen.

Publishing consists of uploading the video file to your
hosting provider; adding a title, description and other
metadata; and creating web links to the published
video.

SETTING POWERPOINT TO 16:9 LAYOUT
1.
2.
3.
4.

Click the Design tab.
Click “Page setup”.
Select the “On-screen show (16:9)” slide size.
Then click “ok”.

Although you can do this with an existing slide deck,
it’s best to start with a new blank presentation.

CONVERTING EXISTING PRESENTATIONS
If you do convert an existing slide deck from 4:3 to
16:9, you will need to review the presentation slide
by slide and fix artifacts introduced by the
conversion. Plain text usually reflows fairly well, but
you may need to adjust the line spacing and any
forced line breaks.
SmartArt also converts very well, automatically
resizing to fit the new space available. However, text
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may not reflow as you expected on some SmartArt
objects, typically requiring an adjustment in font size
or forced line breaks.
Your biggest problem will be with all the photographs
and graphic images. They will all be distorted in
width. You will need to remove the distortion on each
image one by one.

CORRECTING IMAGE DISTORTION
1.
2.

3.
4.

Right-click on the image.
Select “size and position” from the menu. Note
that the scale of the width does not match the
scale of the height. In an undistorted image, they
would be the same.
Within the scale settings, change the width to
match the height.
Click “close” to apply the settings and correct the
distortion on this image.

You’ll need to correct this width distortion on every
image and graphic in the slide deck. You may also
need to rearrange the positions of text and images to
better suit the wider slide format.

AUDIO RECORDING
The simplest approach to audio is to record directly
into your computer with a headset. The location
needs to be free of external distractions and be
relatively quiet. A carpeted room will absorb echoes
and dampen the sound. Close the door and windows,
and turn off any equipment you are not using to
reduce background noise. Unfortunately, headset
microphones vary tremendously in audio quality.
At the other extreme, professional-level recording
involves a lot of expensive hardware.
Fortunately, high-quality digital recorders are now
available at reasonable prices. Originally designed for
musicians and videographers, these devices create
excellent recordings on location and in your “office
studio.” The Zoom H2 and H4n are examples of
technology that “just works.”
Place it on a tripod or mic stand in front of the
presenter, point it at your presenter, and hit record.
Just make sure not to point it at a video projector fan,
or place it on a vibrating table. When finished,

directly copy the audio file from the SD card into your
computer for editing.
The quality of the audio is critical. Nothing turns off
listeners quicker than bad sound. Value your
listeners’ time as well – keep to the point, don’t
“ramble,” and keep it as short and clear as possible.
The speakers’ voices, intonations, and speech
patterns significantly impact the perceived quality of
the final audio track. Apply energy, enthusiasm (you
can hear smiles), and delivery style variation to the
recording. Make sure you express the passion and
authority you have concerning your topic.

AUDIO EDITING
Use audio editing software to remove pauses and any
defects from the recording. Excellent choices are
Adobe Soundbooth, Sony Sound Forge, and the open
source Audacity (with the LAME MP3 encoder). This
software just looks complicated. If you only learn how
to do one thing with audio editing software, use it to
edit out pauses and repeated or unnecessary phrases.
This is accomplished by listening to the audio track,
then stopping and selecting the audio to remove, and
clicking “delete”.

ADDING EDITED AUDIO TO POWERPOINT
1.

Click on the first slide of the presentation to
select it.
2. Click the “Insert” tab.
3. Select “Audio from file”, navigate to and select
the edited audio file. An audio player icon will be
added to the first slide.
4. Click the “Playback” tab.
5. Change the Start playback option to “Play across
slides”. This allows the one audio file to provide
continuous audio across all the slides.
6. Select the “Hide During Show” option. This keeps
the audio player icon from showing on the first
slide in the final video.
7. Click the “Slide Show” tab.
8. Select the “Start Recording From Beginning”
option from the “Record Slide Show” button.
9. Deselect the “Narrations and laser pointer”
option in the “Record Slide Show” dialog box.
10. Put on your headset so you can clearly hear the
audio file, and then click “Start Recording”.
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Your presentation will start as if you are delivering it
to an audience. A “Recording” box appears in the top
left corner. It is automatically keeping track of the
time between slide and animation clicks. Click the
spacebar to advance slides or activate animations
according to your script in synchronization with the
audio track.
Press the spacebar one last time after the last slide to
advance to a final black screen. Make sure to give the
last slide a few moments of display before doing this.
The timed duration of the slide show will be
displayed. Click “Yes” to save the timings.

CREATE VIDEO FROM POWERPOINT
1.
2.
3.
4.
5.
6.

Click the “File” tab.
Click “Save & Send”.
Click “Create a Video”.
Select the “Computer & HD Displays (large
1280x720)” option.
Make sure the “Use Recorded Timings and
Narrations” option is selected.
Click “Create Video”.

YOUTUBE VIDEO METADATA EXAMPLE
Title: Making Videos from PowerPoint Presentations
Description: Learn step-by-step how to create an HD
YouTube video from a PowerPoint 2010 presentation
and a companion audio recording. Whether your
need is lecture or presentation capture, video
podcasting, or creating knowledge on demand
learning modules, this video covers the critical
considerations and processes required. The files used
to create this video are available at
http://users.stlcc.edu/rschumacher/ppt-video.html
Tags: "Microsoft PowerPoint" "lecture capture"
"presentation capture" "how to" "PowerPoint 2010"
"step-by-step" education college e-learning course
"slide deck" "knowledge on demand" presentation
"presentation design" STLCC "St. Louis" Missouri
"Richard Schumacher" university technology software
school campus training
Category: Education
YouTube channel: youtube.com/STLCCedtech

You get to wait a while at this point. Depending on
the size of your presentation, the length of the audio
track, and the speed of your computer, you will get to
watch the little bar at the bottom right slowly crawl
to completion. It is usually a two to one to three to
one wait (a 15 minute presentation may take a half
hour or more to generate).

Direct link: http://youtu.be/aNkfZvjPHFE

When the video is finally created, you can doubleclick on it to review your result.

Quality audio is an essential component of any video
project. Make sure your audio is clear, short, and
dynamic.

PUBLISHING ON YOUTUBE
1.
2.
3.

4.

Go to youtube.com, and sign in to your account.
Select the “Upload” option.
And then “Select files from your computer”.
Navigate to and select the wmv video file you
created.
While waiting for it it upload and process, give it
a title, tags, description, category (education),
and privacy setting.

When the processing is completed, a direct link to the
video appears. Use that link, or go to your YouTube
channel, and view your completed video.

KEYS TO SUCCESS
HIGH QUALITY AUDIO

CONCISE CONTENT
The best PowerPoint videos tell a good story or solve
real-world problems through targeted, concise
content. Edit, edit, edit.

ENGAGING VISUALS
You need effective, thoughtful, engaging visuals, and
highly readable text. Sustaining viewer attention
requires frequent changes – it may be in the slide
content, or it may be the style or tone of the
narration.
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